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1. Summary
_____________________________________________________________________________________________________________________________|

1.1 Key features

This application note describes the asymmetric multiprocessing design (AMP) based on the Xilinx application
note XAPP1093 [1]. The ARM Cortex A9 processor [5] works together with the MicroBlaze processor, sharing the
terminal and block ram. Both processors execute program from the same external DDR3 memory. The
MicroBlaze processor is controlling 4 EdkDSP floating point accelerators. Each accelerator is organised as 8xSIMD
reconfigurable data path, controlled by the PicoBlaze6 controller. This evaluation package is provided by UTIA
for the Xilinx ZC702 designs with AXI bus. This application note explains how to install and use the demonstrator
on Windows7, (32 or 64 bit) and the Xilinx ZC702 board [2],[3], [4]. These key features are demonstrated:

e Implementation of adaptive acoustic noise cancellation on 1 of 4 accelerators is computing the recursive
adaptive LMS algorithm for identification of regression filter with 2000 coefficients in single precision
floating point arithmetic with sustained performance

o 627 MFLOP/s on the 100 MHz EdkDSP
o 146 MFLOP/s on the 666 MHz ARM Cortex A9 (with the vector floating point unit)
o 5 MFLOP/s on the 100 MHz MicroBlaze processor with the floating point HW unit

e The EdkDSP accelerators can be reprogrammed by the firmware. The programming is possible in C with the
use of the UTIA EDKDSP C compiler. Accelerators can be programmed with two firmware programs. Designs
can swap in the real time the firmware in only few clock cycles in the runtime.

e The alternative firmware can be downloaded to the EdkDSP accelerators in parallel with the execution of the
current firmware. This is demonstrated by swap of the firmware for the FIR filter room response to the
firmware for adaptive LMS identification of the filter coefficients in the acoustic noise cancellation demo.

o The EdkDSP accelerator is providing single-precision floating point results bit-exact identical to the reference
software implementation running on MicroBlaze with the Xilinx HW single precision floating point unit.

e The 100 MHz 8xSIMD EdkDSP accelerator is 4,3x faster than the 666 MHz ARM Cortex A9 (with the vector
processing unit) and 125x faster than computation on performance optimized 100 MHz MicroBlaze with
HW floating point unit, in the presented case of the 2000 tap adaptive LMS filter.

e The floating point 2000 tap coefficients FIR filter (acoustics room model) is computed by single 100 MHz
(8xSIMD) EdkDSP accelerator with the floating point performance 994 MFLOP/s. The peak performance
(only theoretical) of the single 100 MHz (8xSIMD) EdkDSP accelerator is 1,6 GFLOP/s.

o The peak performance of four 100 MHz (8xSIMD) EdkDSP accelerators implemented in this demo design is
6,4 GFLOP/s (this is only theoretical, peek figure).

e This evaluation package presents two (8xSIMD) EdkDSP accelerator families: one family without pipelined
floating point divider data path and one family with a single pipelined floating point divider data path. The
members of both families differ by size and by supported vector floating point operations.

e The floating point applications can be scheduled inside of the EdkDSP accelerator by the Xilinx PicoBlaze6
processor [8]. Each firmware program has maximal size of 4096 (18 bit wide words).
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1.2 What is included

The asymmetric multiprocessing on ZYNQ (AMP) with the EdkDSP platform evaluation package contains these
deliverables for the Windows 7 (32 or 64bit):

e 10 evaluation versions of AMP designs. Each design contains one used ARM Cortex A9 processor core, one
MicroBlaze and four instances of the EdkDSP accelerators with 8xSIMD floating point data paths with AXI-lite
bus. (ARM 666 MHz, MicroBlaze 100 MHz, Accelerators 100 MHz) Designs are compiled in Xilinx XPS 14.5
and XST [6].

e UTIA is providing source code for the demo applications and SW projects for the Xilinx SDK 14.5 [7]. These
source code projects are compiled with the UTIA library libwal.a serving for the EdkDSP communication.

e The included evaluation versions of the UTIA EdkDSP accelerators have HW limitation of maximal number of
performed vector operations.

e The UTIA EdkDSPC C compiler is provided as 3 executable applications for Ubuntu in the VMware Player.

e The firmware is also provided in format of binary files to enable testing of accelerators without C compiler.

e Partners of the Artemis EMC2 project [9] can get from UTIA the HW design projects with the evaluation
versions of the EdkDSP accelerators in form of AXI netlist pcores for free. See chapter 6 for specification of
deliverables for the EMC2 project partners and license details.

e Release versions of AMP designs with the EdkDSP package for the Xilinx ZC702 board is offered by UTIA.
All customers can order and buy from UTIA the release version of this AMP demao. It includes the HW design
projects with the EdkDSP accelerators in form of AXI netlist pcores with main limitations removed. See
sections 7 of this application note for specification of deliverables and license details.
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2. Demonstrator AMP with EdkDSP accelerators on ZC702 board

2.1 Description of EdkDSP accelerators and evaluation designs

This application note describes how to set-up and use the collection of 10 HW designs running in an asymmetric
multiprocessing architecture formed by of one ARM processor and one MicroBlaze processor with 4 (8xSIMD)
EdkDSP accelerators on Xilinx ZC702 board. See Figure 1 and Figure 2. The demonstrator serves to evaluation
of parameters of two floating point accelerator families in the AMP architecture on the Xilinx ZYNQ xc7z020-1
part:

o bce_fpl1l_1x8_0_axiw_v1 [10|20]|30|40]_a is a family of four versions of floating point EdkDSP
accelerators with 8 SIMD data paths.

e bce_fpl12_1x8 _0_axiw_v1_[10]|20]|30|40]_a is similar family of four versions of floating point EdkDSP
accelerators with 8 SIMD data paths extended by a pipelined floating point division (FPDIV) in a single
data path.

The four grades [10]20|30]40] of the EdkDSP accelerator differ in HW-supported vector computing capabilities:

The area optimized accelerators bce_fp11l_1x8_0_axiw_v1_10_a and bce_fp12_1x8_0_axiw_v1_10_a perform
vector floating point operations FPADD, FPSUB in 8 SIMD data paths.

The accelerators bce_fp1ll_1x8_0_axiw_vl_20_a and bce_fp12_1x8_0_axiw_v1_20_a perform vector floating
point operations FPADD, FPSUB in 8 SIMD data paths plus the vector floating point MAC operations in 8 SMD
data paths for length of the vector 1 up to 10. These accelerators can be used in applications like floating point
matrix multiplication with row and column dimensions <= 10.

The accelerators bce_fpll_1x8_0_axiw_v1_30_a and bce_fp12_1x8_0_axiw_v1_30_a support identical
operations as the bce_fpll_1x8 0 _axiw_vl 20 _a and bce_fp12_1x8_0_axiw_v1_20_a plus the floating point
vector by vector dot products performed in 8 SIMD data paths. It is optimized for parallel computation of up to 8
FIR or LMS filters, each with size up to 255 coefficients. It is also effective in case of floating point matrix by
matrix multiplications, where one of the dimensions is large (in the range from 11 to 255).

Finally, the accelerators bce_fp11_1x8_0_axiw_v1_40_a and bce_fp12_1x8_0_axiw_v1_40_a support identical
operations as the bce fp1l 1x8 0 axiw vl 30 a and bce fp12 1x8 0 axiw_v1 30_a plus an additional HW
support of dot product. It is computed in 8 data paths with the HW supported wind-up into single scalar result.

The bce_fp11 versions of 8xSIMD accelerators has no support for pipelined vector floating point division and it is
suitable for applications like FIR filters or adaptive LMS filters with no need for floating point division.

The bce_fp12 versions of 8xSIMD accelerators are larger in comparison to the bce_fp11 equivalents and support
in a single data path the pipelined vector floating point division. Accelerators are suitable for applications like
adaptive normalised NLMS filters and the square root free versions of adaptive RLS QR filters and adaptive RLS
LATTICE filters.
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Figure 1: Asymmetric multiprocessing on ZYNQ with ARM, MicroBlaze and
4x ( 8xSIMD) EdkDSP floating point accelerators on Xilinx ZC702 board;

Ten precompiled HW designs combine ARM Cortex A9 with MicroBlaze and four 8xSIMD EdkDSP accelerators.
All designs demonstrate use of single instance of 8xSIMD EdkDSP floating point accelerator on 32bit AXI-lite bus
of the Xilinx MicroBlaze soft-core processor on the Xilinx ZYNQ ZC702 FPGA board with system clock of ARM 666
MHz, MicroBlaze 100 MHz and EdkDSP accelerators 100 MHz. See Figure 2.

Common properties of precompiled evaluation designs:

e The EdkDSP floating point accelerators are reconfigurable during runtime by change of firmware.
e Asymmetric multiprocessing of ARM Cortex A9 and MicroBlaze system with shared external DDR3.
e All demos (HW/SW) have been designed in Xilinx EDK/ISE 14.5 tools [6].

Presented HW accelerators can results in better POWER per MFLOPS ratio for certain class of DSP applications in
comparison to the computation on standard CPUs with standard HW floating point support.

The demonstrator includes source code of set of SW demos prepared for easy import of projects and
compilation in the Xilinx SDK 14.5 [7].
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DDR3 1GByte, (533 MHz).

Shared by ARM and MB. 4 GB for ME and 34 GGE for ARM

h i
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Figure 2: Simplified architecture of AMP with EdkDSP evaluation designs; Xilinx ZC702 board;
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2.2 Resources used by the designs

The resources used by the 10 presented designs are summarised in Figure 3 and Figure 4.

72020-1c fp fp fp fp fp Design size Performance
Add Dot S8 ff Lut Bram Slices LMS FIR
Mul Mac |Prod |Prod|div |% % no(of) % Mflop/s Mflop/s

(4x)

fpll_1x8_10 |8x 20 (58 127(140) |74

(4x)

fpll_1x8_20 |8x 8x 24 |66 127(140) |81

(4x)

fpll_1x8_30 |8x 8x 8x 28 |78 127(140) |93

(4x) (4x) (4x)

fpll_1x8_40 |8x 8x 8x 1x 28 |78 127(140) |93 627 994

mix

fpl1l 1x8 10 |8x

fpl1l 1x8 20 |8x 8x

fpl1l 1x8 30 |8x 8x 8x

fpll_1x8_40 |8x 8x 8x 1x 25 (70 127(140) |85 627 994

Figure 3: AMP designs on ZYNQ, ARM A9, MicroBlaze and 4x (8xSIMD) EdkDSP, no FP division

72020-1c fp fp fp fp fp Design size Performance
Add Dot S8 ff Lut Bram Slices LMS FIR
Mul |Mac |Prod |Prod|div |% % no(of) % Mflop/s | Mflop/s

(4x)

fp12_1x8_10 |8x 1x |22 |64 127(140) (80

(4x)

fpl2_1x8_20 |8x 8x Ix |26 |72 127(140) |87

(4x)

fp12_1x8_30 |8x 8x 8x 1x |30 (84 127(140) |95

(4x) (4x) (4x)

fp12_1x8_40 |8x 8x 8x 1x |1x (30 |86 127(140) |97 627 994

mix

fp12_1x8 10 |8x 1x

fp12_1x8 20 |8x 8x 1x

fp12_1x8 30 |8x 8x 8x 1x

fp12_1x8 40 |8x 8x 8x 1x |1x (27 |76 127(140) |91 627 994

Figure 4: AMP designs on ZYNQ, ARM A9, MicroBlaze and 4x (8xSIMD) EdkDSP, with FP division
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2.3 Asymmetric multiprocessing and use of external DDR3 memory

Presented FPGA designs are running on the Xilinx ZC702 development board [2], [3], [4]. See Figure 1. It is using
the 1GB DDR3 memory with clock signal 533 MHz. The DDR3 is connected to Xilinx ZYNQ xc7z020-1 FPGA by 32
data path. The first % of the DDR3 are reserved for the ARM A9 processor. The last % is used by the MicroBlaze
processor with the EdkDSP accelerators. The presented APP demo is following the Xilinx aapplication note
XAPP1093 [1]. See Figure 2 for the architecture of the design.

2.4 Re-programmability of EdkDSP accelerators

Each of the four 100 MHz 8xSIMD EdkDSP floating point accelerator subsystems contains one reprogrammable
Xilinx PicoBlaze6 8-bit processor and the floating point 8xSIMD DSP unit. The performance of the accelerator is
application specific. In this demo, a single 8xSIMD EdkDSP unit is delivering sustained 994 MFLOP/s in case of
2000 tap FIR filter computation and 627 MFLOP/s in case of the adaptive 2000 tap LMS filter identification
demo. Each design in this package has four 8xSIMD EdkDSP units.

The Xilinx PicoBlaze6 processor has fixed configuration with size of the program memory 4096 (18 bit wide)
words, 64 Bytes scratch pad RAM memory and the interrupt vector in the address 1023.

Each 8xSIMD EdkDSP accelerator works with 2 program memories, each with the 4096 (18bit wide) words. Both
program memories are accessible by MicroBlaze processor via AXl-lite bus. The PicoBlaze6 processor can
execute program from each of these memories. The MicroBlaze application can write new firmware to the
currently unused program memory, while the PicoBlaze6 is executing firmware from second program memory.

2.5 Debug of the AMP system with EdkDSP accelerators in the evaluation package

All EdkDSP accelerators can communicate with MicroBlaze program. The communication is using the Worker
Abstraction Layer (WAL) library API. This API is used for support of writing of the debug information from the
worker to the MicroBlaze terminal. MicroBlaze is using the terminal of the ARM A9 processing system, present
in the ZYNQ processing system. ARM and MicroBlaze communicate via memory controller of the ZYNQ
processing system. See Figure 2.

ARM and MicroBlaze can be both debugged simultaneously from the SDK 14.5 debuggers integrated in the Xilinx
SDK tool. The debugging of both processors is using the Xilinx application note XAPP1093 [1]. The PicoBlaze6
processors [8] can exchange data and text via the 8 bit communication data path with the MicroBlaze processor.
This path is used to communicate parameters to the accelerators and to get messages or reports from
accelerators for debugging.

Floating point data are accessed by the MicroBlaze processor via the dual ported block memories of
accelerators. The MicroBlaze side of the dual-ported memories is mapped into the MicroBlaze memory. The
MicroBlaze processor can copy data from the dual ported memories to the DDR3 global workspace and display
floating point data in the debugger. The computation in the (8xSIMD) EdkDSP units can overlap with the
communication to and from the DDR3 performed by MicroBlaze and supported by data and program cache. A
Ping-Pong swap of memory banks is used. The 8xSIMD EdkDSP firmware is computing (in parallel) in some banks
of all dual ported memories and MicroBlaze is communicating (sequentially) to/from DDR3 in another set of
banks of the dual-ported memories. This process can be stopped, inspected and debugged by the MicroBlaze
debugger from the SDK.
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3. Installation of AMP with EdkDSP platform on the ZC702 board

3.1 Import of precompiled projects and SW into Xilinx SDK 14.5

Unzip the evaluation package to directory of your choice. The directory c:\VM_07 will be used in this
application note. You will get these directories:

c:\VM_07\d_145_7z

19.10.2014 10:24 <DIR>
19.10.2014 10:24 <DIR> .

19.10.2014 10:23 <DIR>  d_72020 fpll 4x8
19.10.2014 10:23 <DIR>  d_72020_fpl1_4x8_IMPORT
19.10.2014 10:23 <DIR>  d_72020 fpll 4x8_v1_10a
19.10.2014 10:23 <DIR>  d_72020_fp1ll 4x8 v1_20a
19.10.2014 10:23 <DIR>  d_72020_fp1ll_4x8 v1_30a
19.10.2014 10:23 <DIR>  d_72020_fp1ll_4x8 v1_40a
19.10.2014 10:23 <DIR>  d_72020_fp1ll_4x8 v1_mxl
19.10.2014 10:23 <DIR>  d_72020 fp12_4x8
19.10.2014 10:24 <DIR>  d_72020_fp12_4x8_IMPORT
19.10.2014 10:24 <DIR>  d_72020_fp12_4x8_v1_10a
19.10.2014 10:24 <DIR>  d_72020_fp12_4x8_v1_20a
19.10.2014 10:24 <DIR>  d_7z020 fp12_4x8_v1_30a
19.10.2014 10:24 <DIR>  d_72020_fp12_4x8_v1_40a
19.10.2014 10:24 <DIR>  d_72020_fp12_4x8 v1_mxl

Select SDK 14.5 workspace in c:\VM_07\d_145_7z\d_7z020_fp12_4x8\SDK_Workspace. See Figure 5.

4 Workspace Launcher x|

Select a workspace

Xilimx SDE stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Workspace: IC:'n,'l.-'M_IZI?'n,cI_HE_?z'n,d_?zEIEEI_Fp12_4x8'|5DK_'LﬁJ'DrkspacE ~|| Browse... |

[ Use this as the default and do not ask again

QK Cancel

Figure 5: Select the SDK Workspace
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Add c:\VM_07\d_145_7z\d_7z020_fp12_4x8\repo_edkdsp path to the UTIA EdkDSP repository.

See Figure 6.

I type filter text

[+ General

- CJC++

-- Help

-- InstallUpdate

-- Remote Systems

-- Fun/Debug

--Team

E----Terminal

=) Xiinx 50K
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Mote: Local repository settings take precedence over global repository settings.

Restore Defaults Apply

Remaove

Lo

Relative

AR

MNew...

Remmove

Cravrm

Hid

QK

Cancel

Figure 6: Include the UTIA EdkDSP Repository

Click on the “Rescan Repositories” button. Click on the “Apply button”, and finally click on the OK button. The
path to the SW drivers has been defined.

signau processing

0-'-'.A Akademie véd Ceské republiky ;
Ustav teorie informace a automatizace AV CR, v.v.i.

http://zs.utia.cas.cz

©2014 UTIA AV CR, v.v.i.
All disclosure and/or reproduction rights reserved




In SDK, select File -> New -> Project ... -> Xilinx -> Hardware Platform Specification. See Figure 7.
Click on the Next button.

ol

Select a wizard —

Wizards:

I\'_»_'lE er \ext

[E:- General
- CfC+H+
E-=- ilinx

----- @ Application Project

------ Wi}, Board Support Package

=g Hardware Platform Spedfication

@:J = Back I Mext = I Fimisti Cancel

Figure 7: Specify the Hardware Platform

In the “New Hardware Project” screen, fill into the Project name:
hw_platform_0

In the New Hardware Project screen, fill into the Target Hardware Specification:
c:\VM_07\d_145_7z\d_72020_fp12_4x8_vl_mx1\SDK\SDK_Export\hw\system.xml

This will specify one of the 10 precompiled HW designs present in the evaluation package. See Figure 8.
We have selected the “mix”design, demonstrating the use of four the UTIA EdkDSP accelerators, all with
8xSIMD data path, with floating point single data path division. The (8xSIMD) accelerators compiled in this
design have four different capabilities defined by the pcores: bce fp12 1x8 0 axiw vl 40 a;

bce fp12 1x8 0 axiw vl 30 a; bce fp12 1x8 0 _axiw_vl 20 a; and bce fp12 1x8 0 axiw_v1 10 a.

This helps to demonstrate all four versions of the EdJkDSP family in a single AMP demo.

Click on “Finish” button to finalize the selection of the precompiled HW design. See Figure 8.
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SI=Es

MNew Hardware Project -
Create a new Hardware Project. |
o | |

Project name: ||‘IWJ:I|E'|:FDFIT|_U

¥ Use default location
Location: IC:'-,'-a'rv1_CI?'-.n:I_HS_Fz'-.n:I_?zEIEEI_fp12_—1x8'-,SDK_'-.-'-;'u:urkspace'-hw _platform_0 Browse. .. |

Chomse file systenm: Idefault vI

—Target Hardware Specdification

Provide the path to the hardware specification file exported from Project Mavigator ar XPS or Vivado or IPT,
This file usually resides in SDK/SDK_Exportfhw folder relative to the ¥P5/Vivado project location.
The spedification file and assodated bitstream content will be copied into the workspace.

I C:\WM_07d_145_72\d_7z020_fp12_4x8_v1_mx 1\SDKASDK_Exportihwsystem, xml Browse.. |
b Bitstream and BMM Files

@ < Back | Mexk = | Finish I Cancel |

Figure 8: Use the name “hw_platform 0" and select one of the provided xml design descriptions

SDK is interpreting the system.xml and presents HW cores of in the design. See Figure 9.

The hardware platform “hw_platform_0" has been created.
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4 C/C++ - hw_platform_0/system.acml - Xilinx SDK

File Edit Source Refactor
| r9-
J @ Qn - J = J e

Mavigate Search Run Project

; |

- - -

Xilinx Tools

E-&8-d-E-]%-0-A- |80 |= 2R S

I (=]

5 |Hg ofo++

Window Help

[ Project Explorer 52

| {F system.xml 3

E--B hw_platform_0
ps7_init.c
ps7_inith
(@ ps7_init.himl
= ps7_init.tc

Design Information

hw_platform_0 Hardware Platform Specification

=0

-

(@) ruﬂ » =0
An outline is not
available.

Target FPGA Device:
Created With:
Created On:

XP5 Design Report:

xC77020

EDK 14.5

Fri Oct 03 10:28:09 2014

file:fiC: VM 0F/d 145 Fz/d 72020

12 48 w1 mx1/SDK/SDK Exporthw/isystem.html

leds_4bits
microblaze_0_intc
debug_module

irg_gen_0
bee_fpi2_ix8_0_axiw_0
bee_fp12_1x8_0_axiw_1
bee_fp12_1x8_0_axiw_2
bee_fpi2_1x8_0_axiw_3
ps7_ddr_0

ps7_ddr_0

Oz40000000
O=z41000000
Ox42000000
0x50000000
0x78700000
Ox782800000
0x78900000
0x78a00000
O=x30000000
Ox30000000

Address Map for processor microblaze_0

Ox4000f£f£
0x41000££1
Ox4200f£££
0xSO000f£f£
Ox787fffff
Ox700fffff
0x789fffff
Ox?8afffff
Ox3fffffff
Ox3fffffff

Address Map for processor ps7_cortexa®_0

ps7_uart_1 O=e0001000
ps7_i2c_0 O=xe0004000
ps7_afi_0 O=f&008000
ps7_afi_i O=f&009000
ps7_afi_2 O=f&800a000
ps7_afi_3 O=f&00b000
ps7_can_0 O=xe0008000

2l

Oxel001fff
Ozel004fff
O=zf8008fff
O=fB009fff
O=fo00=afff
Oxf800bfEff
Oxel00Bfff

O\ter\riew] Source |

[£1 Problems |+ Tasks | B Console 2

SDK Log

= Properh'esw @ Terminaq

1@:35:

1@:35:
1@:35:
1@:35:
1@:38:

55

55
55
59
25

INFO

INFO
INFO
INFO
INFO

: Reading in cores from lecal repositories:

: Updating libgen.options on all BSP projects.

: Cleaning BSP projects in the workspace.

i Saving repository preferences.

: Project "hw_platform_8' created. You can now create BSPs and applicatien projec_|

C:\uM_87\d_145_7z\d_7z@28_fpl2 4x8\repc_edkdsp

|

| o

J=-<>

Figure 9: AMP Hardware Platform with the MicroBlaze and ARM Address Map

SW projects can be imported into SDK now. Select:

File -> Import -> General -> Existing Projects into Workspace

Click on Next button. See Figure 10.

signau processing

Akademie véd Ceské republiky ;
Ustav teorie informace a automatizace AV CR, v.v.i.

(oTiA]

http://zs.utia.cas.cz

©2014 UTIA AV CR, v.v.i.
All disclosure and/or reproduction rights reserved




=

Select

Create new projects from an archive file or directory,

=]

Select an import source:

It'-_;pe filker text

EIIE:- General
- [E Archive File

A

: .2, preferences
E? CjC++

(= Instal

IE:- Femote Systems
IE:- Run/Debug
#-(= Team

----- Q Existing Projects into Workspace

(2)

= Back I Mext = I

Finish | Cancel

Figure 10: Import Existing Projects into Workspace

Type directory with projects to be imported. See Figure 11.
c:\VM_07\d_145_7z\d_72020_fp12_4x8_IMPORT

Set the “Copy projects into workspace” check box.

Click on Finish button. See Figure 11.
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4% Import =10l x|
Import Projects
Select a directory to search for existing Edlipse projects.

(% select root directory: | C:\WM_07\d_145_7z\d_7z020_fp12_4x5_IMPORT Browse...
i~ selact archive file: | Erowse, ..,
Projects:

amp_fsbl (C:\WM_07'd_145_7z\d_7z020_fp12_4xd_IMPORT'amp_fshl) Select All

- [w] amp _fsbl_bsp (C:\WM_07\d_145_7z\d_72020_fp12_4xs_IMPORT\amp_fsbl_bsp)

[l app_cpu_0_1x&_all (C:\WM_07\d_145_7z\d_72020_fp12_4x8_IMPORT\app_cpu_0_1x&_all) Deselect All

[l app_cpu_0_1x&_all_bsp (C:\WM_07d_145_7z\d_72020_fp12_4x8_IMPORT\app_cpu_0_1x&_all_bsp)
[#] edkdsp (C:\WM_07\d_145_72\d_72020_fp12_4x&_IMPORT\edkdsp)

- [w] edkdsp_cc (C:\WM_07\d_145_7z\d_7z020_fp12_4ud_IMPORT\edkdsp_cc)

-[#] edkdsp_fp12_1x&_all (C:\WM_07\d_145_7z\d_72020_fp12_4x8_IMPORT\edkdsp_fp12_1x&_al)

- [w] standalone_bsp_0 (C:\WM_07\d_145_7z\d_7z020_fpi2_4x8_IMPORT\standalone_bsp_0)

Refresh

ik T

¥ Copy projects into workspace

Warking sets
[T Add project to working sets

iarking sets: j Select, ., |

@:J < Back Mexk = | Finish I Cancel

Figure 11: Select Copy Projects into Workspace and Finish the Import of all Projects.
All the UTIA EdkDSP SW projects are imported into SDK workspace from the directory
c:\VM_07\d_145_7z\d_72020_fp12_4x8_IMPORT

Process of compilation will start automatically. This first compilation of all SDK SW projects can take several
minutes to finish. It should finish without errors. See Figure 12.
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3.2 Asymmetric Multiprocessing Demo in Debug Mode

The “app_cpu_1x8_all” project in the “Project Explorer” window of the SDK 15.5 [7] will be used to program
ARM core part of the AMP demo. The “edkdsp_fp12_1x8 all” project will be used to program the MicroBlaze
core and the four EdkDSP accelerators of the AMP demo. The “app_fsbl” project is the first stage boot loader
program for ARM. It will control the boot from the SD card. The “edkdsp” project contains the same SW content
as the “edkdsp _fp12 1x8 all” project and it includes in addition the precompiled libwal.a library for the
MicroBlaze processor. The “edkdsp_cc” directory contains C firmware for the PicoBlaze6 controller and binary
utilities for compilations of code for the EdkDSP accelerators. The UTIA EDKDSPCC compiler can be executed
under the VMware player as a Ubuntu binary application. Inspect also the list of IP blocks and related driver
versions present in the evaluation AMP design. The MicroBlaze processor has access to some ZYNQ peripheral
devices [5] in the AMP design. See Figure 12.

4 C/C++ - hw_platform_0/system.acml - Xilinx SDK ] 4
File Edit Source Refactor Mavigate Search Run  Project Xilinx Tools Window Help
1T - | % -4 - & |@g-a- -G |H-0-%- [ |0 |= |22H|& B | Bg clc++
2o e 2a Py
[T Project Explorer 52 = O |||z system.xml £3 = 0@ I\ﬂ =0
 ||{An outline i t
=] <='|=“>| Lo IP blocks present in the design —I ava‘i,I:b:Z.e sne

'[zc amp_fsbl

@ amp_febl_bsp leds_4bits axi_gpio 1.0Lb

'bc 2pp_cpu_0_1x8_al pr.oc_sys_reset_ﬂ pr.oc_sys_reset 3.00.a
- == microblaze_0 microblaze 8.50.a Datasheet

ﬂ% app_cpu_0_18_al_bsp microblaze_0_intc axi_intc 1.03.a3

S edkdsp debug_module mdm 2.10.a

: ICE edkdsp_cc dock_generator_0 dock_generator 4.03.a

Bz edkdsp_fp12_1x8 al axidlite_mb_0 ani_interconnect 1.06.a

{3 hw_platform_0 axi_interconnect_mb axi_interconnect 1.06.3

&-{# standalone_bsp_0 irg_gen_0 irg_gen 1.00.a
util_bus_split_0 util_bus_split 1.00.a Datasheet

chipscope_icon_0 chipscope_icon 1.06.3

chipscope_vio_0 chipscope_vio 1.05.a

chipscope_ila_0 chipscope_ila 1.05.a

bee_fp12_1x8_0_axiw_0 bece_fp12_1x8_0_axiw 1.40.3
bee_fpi2_1x8_0_axiw_1 bce_fpl2_ ix8_0_axiw 1.30.a
bee_fp12_1x8_0_axiw_2 bce_fpl2 1x8_0_axiw 1.20.a
bee_fp12_1x8_0_axiw_3 bce_fp12_1x8_0_axiw 1.10.3
ps7_axi_interconnect_0 ps7_axi_interconnect 1.00.a

ps7_uart_1 ps7_uart 1.00.a
ps7_i2c_0 ps7_i2c 1.00.a2
ps7_afi_0 ps7_afi 1.00.a
ps7_afi_1 ps7_afi 1.00.a
ps7_afi_2 ps7_afi 1.00.a
ps7_afi_3 ps7_afi 1.00.a
ps7_can_0 ps7_can 1.00.a
ps7_sd_0 ps7_sdio 1.00.a
ps7_ttc_0 ps7_ttc 1.00.a
ps7_ethernet_0 ps7_ethernet 1.00.a -

Overview] Source |

[Z_‘Problems | Tasks | Bl console &3 EProperh’esw L Terminaq dL 9 ’g| LB &H ._'-'||| = E-r5-70
CDT Build Console [edkdsp]

ELF file : edkdsp.elf -]
elfcheck passed.

'Finished building: edkdsp.elf.elfcheck’

1@:43:28 Build Finished (tock 85.392ms)

Figure 12: All projects are compiled. See IP Blocks present in the design.
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In SDK 14.5 [6], set up the jtag communication for the Digilent USB Cable. See Figure 13.

In SDK, select:
Xilinx Tools -> Configure JTAG Settings.

il Configure ITAG Settings

Configure JTAG Settings

Spedfy the JTAG cable to use for communication and JTAG Device Chain configuration of the target board.
These settings affect how ¥XMD connects to the FPGA,

— ITAG Cable

Frequency: I j
Other Options: I

— JTAG Device Chain
{+ Automatically Discover Devices on JTAG Chain

™ Manual Configuration of JTAG Chain
€ 8 5l

FPGA? | Device Name | 10 code | 1R Length |

@::I oK I Cancel

Figure 13: Specify JTAG cable to the Digilelnt USB Cable

In SDK, program the ZC702 board. See Figure 14.

In SDK, select:
Xilinx Tools -> Program FPGA

Click on the “Program” button.

i o i .
Sighae processing http://zs.utia.cas.cz

| lel.A I Akademie véd Ceské republiky 3 . © 2014 _l'JTlA AV CR, v.v.i.
Ustav teorie informace a automatizace AV CR, V.v.i. All disclosure and/or reproduction rights reserved



4T Program FPGA EI
Program FPGA
Specfy the bitstream and the ELF files that reside in BRAM memory

~Hardware Configuration
Hardware Spedfication: C:\WM_07\d_145_7z\d_7z020_fp12_4x3\sDK_Workspacethw_platform_0\system. xml

Bitstream: |C:‘n,".-'M_[J?Ed_I‘}E_?z‘n,d_?zDZD_Fp12_4}(8‘15DK_'|.".|'nrkspacE‘n,l'|'.r-.' _platform_0'system.bit | Browse..

i

BMM File: | Browse, .

—Software Configuration

Processar | ELF File to Initialize in Block RAM |
microblaze_0 bootloop j

@ Program I Cancel

Figure 14: The bitstream system.bit is selected by the tool.
The ZC702 board is programmed with the .bit file now.

On PC, start the Putty terminal. Set 115200 baud and “Flow control” to None. See Figure 15 and Figure 16.

f.?\ PuTTY Configuration il

Categony:

= Sgssinn Options controlling local seral lines |

- — Select a seral line
= Terminal
- Keyboard Serial line to connect to |CO M3
- Bell

- Features
= Window Speed (baud) 115200
- Appearance
- Behaviour
- Translation Stop bits |'|
- Selection ;

- Colours e I None j
(=1~ Connection Flow control Mone -
.. Data
- Proy
- Telnet
- Rlogin
- 55H
- Serial

— Configure the seral line

Data bits B

About Open Cancel

Figure 15: Setup your COM port. Select speed to 115200 baud, and Flow control “"None”
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% PuTTY Configuration X|
Category:
= Sgssiun | Basic options for your PuTTY session |
B Ter L.nglglng — Specify the destination you want to connect to
—|- Temina
Seral line Speed
- Keyboard
- Bell jcom3 {115200
- Features Connection type:
= Window " Raw " Telnet ¢ Rlogin © 55H % Serial
- Appearance B )
... Behaviour Load, save or delete a stored session
... Translation Saved Sessions
- Selection I
-~ Colours Default Settings Load
= Connection cosim_spB05
... Data prepinac L2
- Progy sp6U5 _ s |
- Telnet Delete |
H.h:lgin
(- 55H
- Senal Close window on exit:
" Aways  Never  Onlyon clean exit
About Open Cancel |

Figure 16: Select “Serial” in the category Session and click Open.

The ARM part of the AMP application has to be downloaded to the DDR3 memory, now.
Select the “app_cpu_0_1x8_all” project by clicking on it in the SDK Project Explorer Window.

In SDK, select:
Run -> Debug Configuration ->Xilinc C/C++ ELF

III

Click on the “New launch configuration” in the Debug configuration screen. The “app_cpu_0_1x8_all” project is
open and the ARM executable Debug\app_cpu_0_1x8_all.elf is ready for download to DDR3 on the ZC702 board
via the jtag cable. See Figure 17.

Click on “Debug” button to download the executable. See Figure 17.

Click Yes in the perspective switch dialog window. See Figure 18.
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{* Debug Configurations

Create, manage, and run configurations

& = I

REEER: | H 5 - Mame: | app_cpu_0_1x5_all Debug

It-.e'pe filter text {- Main E,y Source\l P‘%;j Device Initializaﬁ-:ﬂ ﬁ}@ STDIO Connection\l ¥y ]
o E C/C++ Application CjC++ Application:

| Debug'app_cpu_0_1x8_all.elf

""" [t] Cjc++ Remote Application Variables. .. | Search Project... | Sl |
----- @ Launch Group
----- i: Remote ARM Linux Application

-} Target Communication Framework | app_cpu_0_1x8_all Browse... |

Project:

Eli: Xilinx CfC++ELF ~Build (if required) before launching
S Moy cpu 0_1x8_all Debug
-7 Nilink TCF Build configuration: IDEI:uug j
¥ Select configuration using 'C/C++ Application’
™ Enable auto build ™ Dizable auto build
* |se workspace settings Confiqure Workspace Settings...

¥ | Conmect process input & output ko & Eerminal .

Al RLEwert
Filter matched 10 of 10 items | |

® Debug I Close |

Figure 17: Select “app _cpu 0 _1x8 all.elf” code for Debug on ARM

4 Confirm Perspective Switch El

#™%. This kind of launch is configured to open the Debug perspective when it
I"\.. _/,.I suspends,
This Debug perspective is designed to support application debugaing. It
incorporates views for displaying the debug stack, variables and breakpoint
management.,

Do you want to open this perspective now?

[T Remember my dedsion

Figure 18: Click Yes to switch to the debug perspective.
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¥ Debug - app_cpu_0_1x8_all/src/main.c - Xilinx SDK
File Edit Source Refactor Mavigate Search Run  Project Xilinx Tools Window Help

IS =] e

J“v S J%vﬁv%vJ‘@lﬂP |22 S |B|=m | 82FE|E [ | %5 Debug. FEiC/c++
| &= 4 - 4| & - S = gm =
%5 Debug 52 & | i= ¥ T O|[69= varigbles &2 %% Brealq:ointsw (3] xmp Consolew 1147 Registers EﬁModuIes} =0
Eg app_cpu_0_1x8_all Debug [¥ilinx C/C++ ELF] =t 5 | 5 | Y el
E|-- ¥MD Target Debug Agent (19.10. 14 10:52) (Suspended) Name I Value I
S . . .
= m T=hread [.1] {Sus!:ended. Breakpoint hit.) 9= ret 1072994
) —I 1ma|;{} Z:ln.c. 1131 0x00103ec0 = ticks 1049692
w arm-xilinx-eabi-g {19.10.14 10:52) 9+ mfiops 1964608
| CWM_0T\d_145_ 7z\d_7z020_fp12_4x8'SDK_Workspace\app_cpu_0_1x8_al'\Debuc
=
« I | T _'l_I
| I system. xml .| main.c &3 = 8| 5= outline £2 =0
int main() { = =R LS. B
= int main
- Wl wl_ieh =
- El wil_mmu.h
- Zll xpseudo_asm.h
| - &l remap_ocm.h —
- Wl xil_cache.h
- Bl xscutimer.h
Disable L1 cache for 2 -l_-IMEE‘_-_I;OP_ )
xil 5etT1bAttr1butes(exFFche- exeade2); // S=b® TEX=b1@® AP=bll, Domain=b1111, C=b@, fimer ; XScuTimer
- @ TimerElapsed(XScuTimer™®) : unsig
COMM_VAL = 8; - #  GPIO_BASE
== | - #  GPIO_DIRM
- ’ - GPIO_MASK_DATA
* mb beotloop o # COMM_VAL
* T mod ucine EE01 _+n dounlosd M3 cnohlaza alf +a D00 i . - =
4| | » 4 | E
El console &2 &,Tasks}@Terminaq Jr'f._\ Problems} 0 Execumbleﬂ ﬂ Memorﬂ | 5" Eﬂl @l @l | a = - ff -=08
app_cpu_0_1x8_all Debug [¥ilinx C/C++ ELF] C:\WM_07'd_145_7z\d_72020_fp12_4x8\SDK_Workspace\app_cpu_0_1x8_al'\Debug\app_cpu_0_1x8_all.elf {19. 10. 14 10:52) [Console not connected
Process STDIO not connected to console. -
If you'd like to see UART cutput in this console, please modify STDIO settings in the Run/Debug configuration.
Kl ;I_I
[ g* ‘ Writable ‘ Smart Insert ‘ 131: 1 |

Figure 19: Run app_cpu_0_1x8 all.elf from the debugger as free running

The debug perspective is opened and Debug\app_cpu_0_1x8 all can be debugged or started on the ARM core.
See Figure 19. Start the free running of the program from the debugger. It starts to run, with output to the

terminal window. The timer is started with 3ns resolution.

CPUO: on terminal is indicating the output from the

Core_0 of the dual core Cortex A9 of the ZYNQ. The ARM processor is running and waiting in a pooling loop for

handshake with MicroBlaze. See Figure 20.

The ARM application app_cpu_0_1x8_ all.elf has prepared the initial waiting loop code for the the MicroBlaze
processor at the address 0x3000000 in the DDR3. The MicroBlaze has been released from reset by the ARM
application. MicroBlaze is running the initial loop code at the address 0x3000000 now.
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Figure 20: app_cpu_0_1x8_all.elf will write to the terminal the initial text and it will wait for the
MicroBlaze part of the AMPapplication

The MicroBlaze application edkdsp_fp12_1x8_all.elf will be loaded to the DDR3 memory in next steps.
The SDK has to connect to the running MicroBlaze via jtag. The MicroBlaze processor will be stopped under the
jtag control. The edkdsp_fp12_1x8 all.elf code will be downloaded to DDR3 and the MicroBlaze will be started

again by jtag from the second debugger instance.

To open the second debugger instance select in SDK:
Xilinx Tools -> Launch Shell

In this new shell terminal, start the Xilinx MicroBlaze debugger by typing:
xmd

Connect to the MicroBlaze debugging core by typing:

connect mb mdm

The new GDB server will be started for the MicroBlaze at TCP port 1235.
Note: The ARM debugger is using the default TCP port 1234.

See the console on Figure 21.
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[ G\windows | system32\cmd.exe - xmd
Microsoft Windows [Uerze 6.1.76811
Copyright <c» 2087 Microszoft Corporation. Usechna prava vyhrazena.

CasUM_@d_145_P=d_7=020_fpl12_4xB8~5DK_Workspace >xmd
Hilinx Microprocessor Debugger (XMD» Engine

Hilinx EDK 14.5% Build EDK_P.58f

Copyright (c>» 199520812 Xilinx,. Inc. All rights reserved.

HMD:
#MD:x connect mbh mdm

JTAG chain configuration

IR Length Part Hame
4haBf4d’?? 4 Cortex—AY
23727893 [ RC7ZR2H

MicroBlaze Processor Configuration :
Performance

Mo of PC Breakpoints

Mo of Read AddesData Watchpoints...@

Mo of Write Addr-Data Watchpoints..A
Instruction Cache Support on
Inztruction Cache Basze Addre Bx308000H0A
Instruction Cache High Address Bx3fffffff
Data Cache Support on

Data Cache Baze Address @x 30000000
Data Cache High Address BuIfffffff
Exceptions Support

FPFU Support

Hard Divider Support

Hard Multiplier Support on — (Mul3Z>
Barrel Shifter Support

MER clr-set Instruction Support....on

Compare Instruction Support

Data Cache Write—-back Support

Fault Tolerance Support

Stack Protection Support

Connected to "mb" target. id = 8
Starting GDB zerver for '"mh" target (id = B> at TCP port no 1235
MDD

Figure 21: Start second GDB server at TCP port 1235

The MicroBlaze debug can be started now.
Select the “edkdsp_fp12_1x8 all” project by clicking on it in the SDK Project Explorer Window.

In SDK, select:
Run -> Debug Configuration ->Xilinc C/C++ ELF

Click on the “New launch configuration” in the Run configuration screen. The “edkdsp_fp12_1x8_ all” project is
open and the MicroBlaze executable Debug\edkdsp _fp12_1x8_all.elf will be ready for download to the DDR3 on
the ZC702 board via the jtag cable, to the address 0x30000000. See Figure 22.
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4" Debug Configurations

Create, manage, and run configurations

T -+
L &= p | T g Mame: Iedkdsp_fplz_lxﬁ_all Debug
ype filter text Main . B Souroe\l % Device Initializatio\l . STDIO Connectinn\l Remote Debugw i)
% CfC++ Application Cjc++ Application:
~-[C | CfC++ Attach to Application
Debug\edkd: 12_1x8_all.elf
E C/C++ Postmortem Debugger I ebugledkdsp_fp12_1x8_all.e
E C/C++ Remote Application Variables. .. | Search Project... | Browse. .. |
@ Launch Group Project:
z Remote ARM Linux Application
{ﬁ Target Communication Framework I edkdsp_fp12_1x8 &l Browse... |
EX Xilinx C/C++ELF —Build (if required) before launching
x app_cpu_0_1x&_all Debug
x edkdsp_fp12_1x8_all Debug Build configuration: IDEhug j
f: Xilinx TCF ¥ Select configuration using 'C/C ++ Application’
{" Enable auto build " Disable auto build
¥ Use workspace settings Configure Workspace Settings. ..

[¥ | Conmect process input & output bo)a terminal .

apply | Rewert |
Filter matched 11 of 11items

@:I Debug I Close

Figure 22: Select “edkdsp_fp12_1x8_all.elf code for remote debug on MicroBlaze

This debug session will need 2 adjustments to co-exist together with the running ARM debug session. See
Figure 23 and Figure 24.

Select the Device Initialisation dialog screen and delete the default initial .tcl script. It is not needed in this case.
The Programmable System has been already initiated by the first ARM debug session. See Figure 23.

Select the Remote debug screen and select: Connect to GDB on another machine (we will be connecting to the
second TCP server on the same machine indicated as localhost). See Figure 24.

Change the port from the default 1234 to the port 1235 used by the second server. See Figure 24.
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{f Debug Configurations

Create, manage, and run configurations

| type filter text

€] CjC++ Application

[T ] Cfc++ Attach to Application
--[£] €fC++ Postmortem Debugger
--[£] €fC++Remote Application

[ Launch Group

- §7 Remote ARM Linux Application
E Target Communication Framework
- & ilinx C/C++ELF

&L app_cpu_0_1x3_all Debug

Filter matched 11 of 11items

Figure 23: Clear the pre-defined .tcl file in the Device Initialization sub-screen

. &  department of
sign=a; processng http://zs.utia.cas.cz

N
26/48

@ Akademie véd Ceské republiky . _ ©2014 UTIAAV CR, v.v.i.
Ustav teorie informace a automatizace AV CR, v.v.i. All disclosure and/or reproduction rights reserved




4" Debug Configurations

Create, manage, and run configurations

4 +

LT &= b | - 5= T Mame: Iedkdsp_fplz_lxﬁ_all Debug

| type filter text Main [ Source [ ', Device Initializatio |, STDIO Cannection | [3] Remote Debug .2
~[E] ¢/c++ Application ¥ Connect to gdbserver on a different machine.

--[£] €fC++ Attach to Application
E C/C++ Postmortem Debugger
(] CfC++ Remote Application

Remaote GDB Server

To open a gdbserver, launch XMD on the remote machine, and connect to the processor.
¥MD will then report the port at which the gdbserver is open.

@ Launch Group
z Remate ARM Linux Application IP Address: IIocthost
{ﬁ Target Communication Framewaork Part; I 1235

=-§7 silinx CjC++ELF
x app_cpu_0_1x&_all Debug
- §7 ledkdsp_fp12_1x8_all Debug
-0 ilinx TCF

Apply | Revert |

Filter matched 11 of 11items

@ Debug I Close |

Figure 24: Select Connect to gdbserver on different machine and modify port to 1235

Click on Apply to apply both changes. See Figure 24.
Click on Debug to start the debuger.

The program edkdsp fp12_ 1x8 all.elf will be downloaded to DDR3 from address 0x3000000 and this second
remote MicroBlaze debug section will be opened in the SDK, together with the already running ARM debug
section. See Figure 25.
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4t Debug - edkdsp_fp12_1x8_all/src/fp12_4xB_all.c - Xilinx SDK I ] 3

File Edit Source Refactor Mavigate Search Run  Project Xilinx Tools Window Help

[Nt Gll@m | H-0-Q%- % =2 25z 0| = |2 B | %5 pebug ERC/CH+
@ - 48 -6l G- -

T Debug 52 & | i ¥ T O|[t9= variables &2 % Brealq:oints} (] xmp Console} 1147 Registers | =i Modules} =0
Eg app_cpu_D_le_aIl Debug [¥ilinx C/C++ ELF] =t 5 | 5 Y el
i [Zg ¥MD Target Debug Agent (19. 10,14 10:53) I I
N R @ Thread [1] (Running) Han Value
q ()= Status 805306884
p_, arm-xilinx-eabi-gdb {19, 10. 14 10:59) 9= worker 0

L e C:WM_0TVD_145_7r\d_7z020_fp12_ 4x8\SDK_Workspace\app_cpu_0_1x8_al\Debug
EI Y edkdsp _fpi12_1ix&_all Debug [Xilinx CfC++ ELF]
[=-&# %MD Target Debug Agent (19,10, 14 11:09) (Suspended)
E|u]"3 Thread [1] (Suspended: Breakpaint hit.)
R main() fp12_4x%8_all.c:3633 0x3000e3e8
-p| mb-gdb (19.10.14 11:07) =]
g C:WM_0TVA_145_7z\d_72020_fp12_4x8\SDK_Workspaceedkdsp_fp12_1x8_all\Debi

« | |1 _'l_I
| I system. xml [] fp12_4x8_all.c 3 = 8| 5= outline £2 =0

xil_printf("\rin"); 2 HlER NN o %Y
while ((Xil _In32(UART_BASE + @x2C) & @x@8) != @x@s) g
; stdio.h ﬂ
return (8); - &l platform.h
} ol il _jo.h
IJ xintc.h
= int main(void) { - Wl xparameters.h
. - Bl xil_exception.h
int Status; - # FAST_IRQ_EN
int worker;
-~ # IRQ_GEN_ID
I init_platform(); - IRQ_GEN_INTERRUPT_ID
- #  INTC_DEVICE_ID
irgq_count = @; - INTC
Lol - #  INTC_HANDLER
AL AL LA SRS EA _ILI - #  IRQ_PCORE_GEN_BASE _ILI
K| » 4 | »
El console &2 E,Tasks} & Terminal | L_\ Problems} O Execumbleﬂ ﬂ Memorﬂ | 5N UHl'EIl @l| a a - _& =B
edkdsp_fp12_1x8_all Debug [Xilinx C/C++ ELF] C:\VM_07\d_145 7z\d_7z020_fp12 4x8\SDK_Waorkspace\edkdsp_fp12 1x8_al\Debug'edkdsp_fp12_1x8 all.elf (19.10.14 11:09) [Conscle not cann
Process STDIO not connected to console. ;I

If you'd like to see UART cutput in this console, please modify STDIO settings in the Run/Debug configuration.

4 o

‘ Writable ‘ Smart Insert ‘ 3633:1 J

Figure 25: Debug view with ARM and MicroBlaze. ARM is running. Start MicroBlaze.

The ARM application is running. The MicroBlaze application is downloaded into DDR3 and the debugger is
waiting on the automatically inserted break point in the first MicroBlaze instruction. See Figure 25. You can
step through the MicroBlaze program or start free run of the program.

Run the MicroBlaze to get the output on the terminal from both processors (ARM and MicroBlaze) running in
parallel in the free run in the asymmetric multiprocessing configuration. See the terminal output on Figure 26.

The demo application (2000 coefficient FIR filter) and (2000 coefficient LMS identification of filter coefficients) is
computed in single precision floating point on ARM CPUO first. Same demo application (2000 coefficient FIR
filter) and (2000 coefficient LMS identification of filter coefficients) is computed in single precision floating point
in the first 8xSIMD EdkDSP accelerator (with support from MicroBlaze) next. Finally, the same demo application
(2000 coefficient FIR filter) and (2000 coefficient LMS identification of filter coefficients) is also computed in
single precision floating point on MicroBlaze with the HW floating point unit to verify the EdkDSP result.

See Figure 26.
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22 COM3 - PuTTY

CPUQ: Timer init
CPUO: EReady for EMCZ AMP demo

CPUQ: Far-end signal
CEUO: FIR Room response
CPUO: FIE mflop= 36
CPUQ: HNear-end =signal
CPUOO: LMS identification
CEUD: LMS mflop=s 42

MEDO : (EdkDSP
MEDO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (HW FP } Far-end =ignal

MBO : (EdkD5SP 8x5IMD) FIR room response
CPUD: (EdkDSP 8xS5IMD) FIR mflops 990

MBO : (HW FP unit } Add near-end signal
MBO : (EdkDSP LM5 Tdentification
CPUD: (EdkDSP LM5 mflops 627

MBO : (HW FP uni } LMS TIdentification
CPUQ: (HW FP uni } LMS mflops 2

MBO : (EdkDSP B8xS5IMD) OK

13FFFF
11FFFF
11BFFF
103FFF

S S R e I s O

£
I
ot

MBO : (EdkDSP D) Write firmware

MBO : (EdkDSP D) o iliti 1 = 13FFFF
MBO : (EdkDSP D) o iliti = 11FFFF
MBO : (EdkDSP D) o iliti = 11BFFF
MBO : (EdkDSP D) o iliti 103FFF
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP

&
i

1 [

2"- H= o]

H= v ]
- [ [

Figure 26: Terminal output from the debugged AMP demo application.

signau processin .
g P g http://zs.utia.cas.cz

e | Akademie véd Ceské republiky 5 ©2014 UTIA AV CR, v.v.i.
Ustav teorie informace a automatizace AV CR, v.v.i. All disclosure and/or reproduction rights reserved




The AMP demo continues with testing of all basic vector floating point operations of the 8xSIMD accelerator.
These tests vector operations are also computed in single precision floating point on MicroBlaze with the HW
floating point unit to verify the EdkDSP result. See Figure 26. The demo application loops infinitely, and the test
is performed in a sequence on all 4 (8xSIMD) EdkDSP accelerators. The accelerators are named worker1 ...
worker4. Workers have different capabilities (in case of the mix HW design). This is reflected in the output from
tests. Worker 1 supports all vector operations, worker 2 less, worker 3 even less and worker 4 supports only
minimal set of vector operations. This corresponds to the four (8xSIMD) EdkDSP cores used in the design:

Worker 1 =bce _fpl12 1x8 0 axiw_vl 40 a;
Worker 2 =bce_fpl12 _1x8 0 axiw_vl 30 a;
Worker 3 =bce _fpl12 1x8 0 axiw_vl 20 a;
Worker 4 = bce_fp12_1x8 0 _axiw_v1_10 a.

The capabilities of each worker are reported by each worker to the MicroBlaze. See Figure 26.

Each of the two parallel running processors (ARM and MicroBlaze) can be stopped/resumed/terminated from
the debugger.

The debug session has to be stopped from the debugger and the second GDB server can be stopped from the
shell window by typing:

stop to stop the MicroBlaze processor

rst to perform the system reset

exit to exit from the second GDB server program
exit to close the console

See Figure 27.
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e G\windows | system32\cmd.exe

Device ID Code IR Length Part Mame
i 4halid4?? 4 Cortex—AY
2 23727093 7] HC7EAZA

Optimization
Interconnect

Breakpoints

Mo of Read Addr-Data Watchpoints...A

Mo of Write Adde-sData Watchpoints..A

Instruction Cache Support on

Instruction Cache Base Address @x 30080000

Instruction Cache High Address BxIfFEEEff

Data Cache Support on
d:xx3A8A0AAA

Data Cache High Address Bx3fffffff
Exceptionsz Support

FPU Support

Hard Divider Support

Hard Multiplier Support on — “Mul32>

Barrel Shifter Support

MER clrsset Instruction Support....on
Compare Instruction Support

Data Cache Write—hack Support

Fault Tolerance Support

Stack Protection Support

Connected to “mh" target. id = @
Starting GDB server for "mh" target ¢id = 8> at TCP port no 1235
AMD:: Error: No Data on the Socket

Software Breakpoint B Hit,. Processzor Stopped at Bx300H0eied
Uzer Interrupt, Processor Stopped at BxIBB0Be480
Connection Terminated hy Client

Procezszor stopped

AMD: ret
Suystem reset successfully

a
HHDx exit

CasUM_@A@7d_ 145 Y=sd_7=020_fpl2_ 4x8-~5DK_Yorkspace?>

Figure 27: Stop, Reset and Exit from the second GDB server
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3.3 Asymmetric Multiprocessing Demo with Optimised Code

All demos can be recompiled into the faster release mode with the -0O3 optimization to get increased

performance of ARM and MicroBlaze processors. In SDK 14.5, recompile all projects to the release subdirectories
and delete the debug subdirectories.

Switch-OFF and ON the ZC702 board.
Repeat all steps described in section 3.2, to run the optimised version of the AMP demo.
Start with application app_cpu_0_1x8_all.elf for the ARM processor. See Figure 28.

4 Debug Configurations

Create, manage, and run configurations

L

X | 0O -

L
[r-u ]

Mame: I app_cpu_0_1x3_all Release

I type filter text Main . T S““’Ca “ Device Iniﬁalizatio] " STRIO Connecﬁorq Remote DEbwﬂ "2
% C/C++ Application €/ ++ Application:
i ] CfC++ Attach to Application
E Rel 0_1x8_all.elf
E C/C++ Postmortem Debugger I cleaselapp_pu_0_L:G_al.¢
~[£] cfc++Remote Appiication

Variables. .. | Search Project... | Browse. .. |
F Launch Group Project:
Y Remote ARM Linux Application
Fﬁ Target Communication Framewark I app_cpu_0_1x3_all Browse... |
E‘ Y Xilinx CfC++ELF —Build {if required) before launching
: Mzpp_cpu_0_1x8_all Release
i' xilinx TCF Build configuration: IRelease j
¥ Select configuration using 'C/C++ Application’
" Enable auto build ™ Disable auto build
¥ Use workspace settings Configure Workspace Settings. ..

¥ | Conmect process input & output ta & terminal.

apply Fevert
Filter matched 10 of 10 items | |

@j Debug I Close |

Figure 28: Open the app_cpu_0_1x8 all.elf application (compiled for release) in the ARM debugger.

Start the free run on the ARM CPUO. See Figure 29. There is no source code debug information, now.
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4T Debug - Source not found. - Xilinx SDK _ ||:||£|

File Edit Navigate Search Run Project Xilinx Tools Window Help

| r9- & |#-0-Q@-|x[-n® | PER|ID e 2R 75 [45 pebug R Clc++

PRI

T Debug 52 & | i ¥ T O|[t9= variables &2 % Brealq:oints}@!MD Console} 1147 Registers E'ﬁModuIesw =0
Eg app_cpu_0_1x8_all Release [Xilinx C/C++ ELF] i 24 - | Eﬂ‘ | Y el

E|-- ¥MD Target Debug Agent (19.10. 14 11:24)

88 Thread [1] (Running)

gl arm-silinx-eabi-gdb (19,10, 14 11:24)

e C:WM_0T\A_145_7z\d_72020_fp12_4x8'\SDK_Workspace\app_cpu_0_1x8_al\Relea:

-
« | |1 _'l_I
Elmain) &2 = 8| 5= outline £2 =0

Mo source avaiable for “main() An outline is not available.

View Disassembly... |

El console 53 02, Tasks} @ Terminal Jr:‘._\ Problems} 0 Execumbleﬂ ﬂ Memorﬂ | 5" Eﬂl @l @l | a = - L=<j -=08
app_cpu_0_1x8_al Release [Xiinx C/C++ ELF] C:\WM_07\d_145_7z\d_7z020_fp12 4x8\SDK_Workspace\app_cpu_0_1x8_all\Release\app_cpu_0_1x8_all.elf (19.10.14 11:24) [Console not connec:

Frocess STDIO not connected to console. ;I
If you'd like to see UART cutput in this console, please modify STDIO settings in the Run/Debug configuration.

4 o

Figure 29: Run the app_cpu_0_1x8_all.elf application on ARM

In SDK, open new Shell. Type: xmd

In XMD type: connect mb mdm

Select “edkdsp_fp12_ 1x8_all” project by clicking on it in the SDK Project Explorer Window.

In SDK, select:

Run -> Debug Configuration ->Xilinc C/C++ ELF

Click on the “New launch configuration” in the Run configuration screen. The “edkdsp fp12_1x8 all” project is
open and the MicroBlaze executable Release\edkdsp fp12_ 1x8 all.elf will be ready for download to the DDR3
address 0x30000000. This debug session will again need the adjustments. Select the Device Initialisation dialog
screen and delete the initial .tcl script. Select the Remote debug screen and select: Connect to GDB on another
machine and port 1235. Start debug and free run the MicroBlaze code.

The terminal output will demonstrate the increased MFLOP/s performance of the ARM processor and the
increased performance of the MicroBlaze processor. See Figure 30.
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22 COM3 - PuTTY

CPUQ: Timer init
CPUO: EReady for EMCZ AMP demo

CPUQ: Far-end signal
CEUO: FIR Room response
CPUO: FIR mflop=s 172
CPUQ: Near-end =signal ...
CPUOO: LMS identification
CPUQ: LMS mflops 146&

MEDO : (EdkDSP
MEDO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (HW FP } Far-end =ignal

MBO : (EdkD5SP 8x5IMD) FIR room response
CPUD: (EdkDSP 8x5IMD) FIR mflops 994

MBO : (HW FP unit } Add near-end signal
MBO : (EdkDSP LM5 Tdentification
CPUD: (EdkDSP LM5 mflops 627

MBO : (HW FP uni } LMS TIdentification
CPUQ: (HW FP uni } LMS mflop=s 5

MBO : (EdkDSP B8xS5IMD) OK

13FFFF
11FFFF
11BFFF
103FFF

S S R e I s O

£
I
ot

MBO : (EdkDSP D) Write firmware

MBO : (EdkDSP D) o iliti 1 = 13FFFF
MBO : (EdkDSP D) o iliti = 11FFFF
MBO : (EdkDSP D) o iliti = 11BFFF
MBO : (EdkDSP D) o iliti 103FFF
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP
MEBO : (EdkDSP

&
i

1 [

2"- H= o]

H= v ]
- [ [

Figure 30: Terminal output from the recompiled optimized AMP demo application.
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3.4 Asymmetric Multiprocessing Demo with Boot from SD Card

The AMP demo can be booted from the SD card without the need of jtag booting. This section describes steps
needed to create the image. The ARM application code needs to be slightly modified.

Open the main.c source code in app_cpu_0_all project in the SDK Project Explorer. Comment the two lines as
indicated in Figure 31. This is the section of program, where ARM processor writes in the MicroBlaze assembly
code in hex format a loop to itself program for the MicroBlaze, starting at the DDR3 address 0x3000000. This is
needed only in the case of the jtag boot of MicroBlaze from the second remote debugger.

In case of the boot of the AMP demo from the SD card the first stage boot loader program amp_fsbl.elf will be
instructed to write the final MicroBlaze program from the address 0x3000000.

4 C/C++ - app_cpu_0_1x8_allfsrc/main.c - Xilinx SDK ] 4
File Edit Source Refactor Mavigate Search Run  Project Xilinx Tools Window Help
|9~ ol® -8 l@-&-d-¢-|%-0-4-|x |0 |= |2R|& & | Hg cre++
2] = B2
| &5 - || slE ) | -5 -0 G-
[ Project Explorer &2 = O || [c] main.c &3 =8l(@ I\ﬂ » =g
= = - =
=R=NK4 COMM_VAL = 8; 2
< =
@ amp_fsbl = T
amp_fsbl_bsp o
B2 app_cpu_0_1x3_all * mb bcctlc?p . *
__i,}b Binaries * If not using FSBL to download Migroblaze elf to DDR s Bl xil o4
cud * the reset vector of the Migroblaze needs to contain . xil_mm
: & Includes * a 'branch to self' in order to provide the Migroblaze ] L. 5 xpseu
Bl-{= Release * yalid code to run before before the debugger can halt = M | " rema
Bl src * the Microblaze and download the application thet =} & - A
€] main.c * places valid code at the Microblaze's reset vector - m_ca.t
[B| remap_ocm.h . e o xscuti
T Iscript.d * If using SDK/XMD to download the Microblaze application - i # TIMER
README, bet * uncomment the following two lines of code = e @ timer :
- app_cpu_0_1x8_all_bsp BRERRRRARRE L . (A @ Timert
B-2E edkdsp P . . s # GPIO_
//  Xil_Out32(@x3e@eeees, exbseeseee); M # oo
1= edkdsp_cc // ¥il_DCacheFlush(dy; 2 i o GPIO-
BT edkdsp_fp12_1x8_al —
-3 hw_platform_0 R R A A N 7777 . | | f‘* ComMp—
-8 standalone_bsp_0 // Data memory barrier. RME A #
// activities related to memory are done on HW. L o # NN
dmb (); e # mm
.................................................. #
JITTEEEE LI PRI T FEdddddddiisddiiridsissddss . M i # MM
// Take PL out of reset = M #
// Enable emig bite .
¥il Out32(GPIO_DIRM, @xl1); # ERR
...... ® draw_
Ny 77 . | @ draw_
// Set emig[e] to release PL reset I [ | @ draw_
¥il Out32(GPI0 _MASK DATA, exfffeo@l); M . o draw_
. | [ ® draw_
unslgned TN L = || - o daw =
1 | o el
[&Problems E.Tasks El consale 32 EProperﬁesW@Terminaq L4 <}==='>| '—E Eﬁ |_-'||| = E-C5- 70
CDT Build Console [app_cpu_0_1x8_all]
text data bss dec hex filename ;I
42024 9384 163824 215152 34878 app_cpu @ 1xB all.elf
'Finished building: app_cpu_@ 1x8_all.elf.size’
12:21:37 Build Finished (tock 45.727ms)
« | 2 =

| ¢

‘ Writable ‘ Smart Insert ‘ 1163: 1 J

Figure 31: Modification of ARM code for boot of the AMP application from SD card.

In SDK, select:

Xilinx Tools -> Create Zyng Boot Image
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Fill all the paths as indicated in Figure 32. The sequence is important. First add the amp_fsbl.elf. Second add the
system.bit file. Third is the application code for ARM processor. Fourth is the application code for the MicroBlaze

processor.

df Create Zynq Boot Image

Create Zynq Boot Image
Creates Zyng Boot Image in .bin and .mcs formats from given FSBL elf and partition files in specified output folder.

Basic | Advanced I

Bif file ICreate a new bif file. ..

FSBL elf | C:WM_07\d_145_72\d_7z020_fp12_4x3\sSDE_Warkspace\amp_fsbl\Debugiamp_fsbl.elf
List of partitions in the boot image.

Browse

File | Offset | Alignme
C:\WM_07\d_145_7z\d_7z020_fp12_4x8'SDK_Workspace\amp_fsbl\Debug'\amp_fshl.elf
C:\WM_07\d_145_7z\d_7z020_fpi12_4x8_vi1_mx1\SDKA\SDE_Exportihwisystem.bit
C:\WM_07\d_145_7z\d_7z020_fp12_4x58'\SDK_Workspace\app_cpu_0_1x3_al'\Release\app_...
C:\WM_07\d_145_7z\d_7z020_fp12_4x5'\SDK_Workspace\edkdsp_fp12_1x3_all'\Release'ed. ..

1| | i

Qutput folder | C:\WM_07\d_145_7z\d_7z020_fp12_4xd‘\bootgen

Add
Remove
Up

[y

Browse

AR ITEN

@:I Create Image |

Cancel

Figure 32: Select files for generation of BOOT.BIN image file for the SD card

Click Create Image and the tool will generate edkdsp _fp12_ 1x8 all.bin in the bootgen directory.

Copy edkdsp_fp12_ 1x8 all.bin to the SD card to the top level directory and rename it to BOOT.BIN on the SD

card.

Insert the SD card and power up the ZC702 board. The board will boot from the SD card with output to the

terminal. The output will be identical to Figure 30.
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3.5 Evaluation of EdkDSP C compiler

This section is describing the use of the UTIA EdkDSP C compiler to recompile the firmware for the PicoBlaze6
controller present in each of the four (8xSIMD) EdkDSP accelerators in the AMP evaluation designs for the ZYNQ
ZC702 board.

The evaluation package includes also precompiled files with the firmware ready for download from PC to the
ZC702 board. These files can be used to test the demo without installation of the EdkDSP C compiler to your PC.

The UTIA EdkDSP C compiler is provided as implemented as several Ubuntu binary applications.
The “VMware player” software and the compatible Ubuntu image version is needed to run the UTIA EdkDSP C
compiler on Windows 7 (64bit or 32bit) PC.

The Ubuntu image used in UTIA needs two DVD disks (8GB) for installation. That is why it is not included as part
of the evaluation package. If you would need this image, write an email request to kadlec@utia.cas.cz to get
these two DVD with correct Ubuntu image from UTIA (free of charge).

Install from the Internet the VMware Player software (64bit or 32bit) on your PC.

g Ubuntu_EdkDsP

Ubuntu_EdkDSP

State: Powered Off
05: Ubuntu
Version: Workstation 5. virtual machine
RAM: 512 MB

@ Play virtual machine

éyf’?’ Edit virtual machine settings

Figure 33: Select the Ubuntu_EdkDSP image in the VMware Player and click “Play .
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Open the VMware Player and select the “Ubuntu_EdkDSP” image. The Ubuntu will start.
Login as:

User: devel

Pswd: devuser

The PC directory c:\VM_07 needs to be shared by Windows 7 with Ubuntu.

In Windows 7, set the directory c:\VM_07 and its subdirectories as shared with the __ vmware_user__ for Read
and Write.

In Ubuntu, open terminal and mount the PC directory c:\VM_07 to Ubuntu.
The Windows 7 c:/VM_07 directory is mounted to the Ubuntu OS as: /mnt/cdrive

In Ubuntu terminal, change the directory to:
/mnt/cdrive/d_145 7z/d_72020 fp12_4x8/SDK_Workspace/edkdsp_cc

The EdkDSP C compiler utilities have to be on the Ubuntu PATH. This is done by sourcing the settings.sh script in
this directory.

Type in Ubuntu terminal:
source settings.sh

In Ubuntu terminal, change the directory to the example directory:
cda

devel@ubuntu:/mnt/cdrive/d_145_7z/d_72020 fp12_4x8/SDK_Workspace/edkdsp_cc/a$

See these steps in Figure 34.
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=N
43 Aplikace Mista Systém & po, 20. i, 0s:40 UsA [ @ @ B «[¢)

[= devel @ ubuntisimnty canve/d SIS 5T XSSP RIWorKspacefedkdsprocla =] =

Soubor Upravit Zobrazit Terminal Karty MNapovéda

devel@ubuntu: /mnt/cdrive/d_145 7z/d_7z020_fpl2_4x8/SDK_Workspace/edkdsp_cc$ source settings.sh
EdkDSP environment set to '/mnt/cdrive/sd_145 7z/d_7z020 fpl2_4x8/SDK_workspace/edkdsp_cc'
devel@ubuntu: /mnt/cdrive/d_145 7z/d_7z020_fpl2_4x8/SDK_Workspace,/edkdsp_cc$ cd a

devel@ubuntu: /mnt/cdrive/d_145 7z/d_7z020_fpl2_ 4x8/SDK_Workspace/edkdsp_cc/a% ls

devel@ubuntu: /mnt/cdrive/d 145 7z/d 7z020 fpl2 4x8/SDK Workspace/edkdsp _cc/a% ca fpll.sh a
EDKDSPCC : a_fpllOlpO.c ...

EDKDSPASM: FALL1O1PO.PSM ...

Generated M function file in the M file ././f1ll FAllOLPO program_store.m
Generated C header file in the H file ./fill_FA1101P0 program store.h

EDKDSPCC : a_fpllolpl.c ...

EDKDSPASM: FAL1101P1.PSM ...

Generated M function file in the M file ././fi1ll_FA1101P1 program store.m
Generated C header file in the H file ./fill_FAl101P1_program_store.h

EDKDSPCC : a_fpll24p0.c ...

EDKDSPASM: FAL124P0.PSM ...

Generated M function file in the M file ././f1ll_FAl124P0_program_store.m
Generated C header file in the H file ./f1ll_FAl124P0_program_store.h

EDKDSPCC : a_fpll2dpl.c ...

EDKDSPASM: FAL1Z24P1.PSM ...

Generated M function file in the M file ././f1ll FAl1l24P1 program_store.m
Generated C header file in the H file ./fi1ll FAl124P1 program store.h
devel@ubuntu: /mnt/cdrive/d 145 7z/d 7z020 fpl2 4x8/SDK_Workspace/edkdsp _cc/a% 1s

devel@ubuntu: imnticdrive!d_l45_?zid_?z@2@_fp12_4x8fSDK_\~|'0rkspace,‘e&(dsp_cc,‘aﬂ; |

@ [ devel@ubuntu: fmnt/ed...
To direct input to this virtual machine, press Cid+G. @ ymware:

Figure 34: Compilation of EdKDSP firmware in Ubuntu.

C source code examples can be compiled by the script ca_fpl1.sh with parameter a.
Type in the Ubuntu terminal:
ca_fpllssha

This will compile and assemble all four C firmware programs to header files with the firmware binary code:
a_fp1101p0.c is compiled to fil_FA1101P0_program_store.h
a_fp1l101pl.c is compiled to fill_FA1101P1_program_store.h
a_fpl1124p0.c is compiled to fill_FA1124P0_program_store.h
a_fpl124pl.c is compiled to fill_FA1124P0_program_store.h

Copy and paste the compiled headers into the src directory of the MicroBlaze project
“edkdsp_fp12_1x8 all” of the SDK 14.5 AMP demo.

See the initial list of C firmware files for the EdkDSP in the SDK before compilation in Figure 35.
See the generated header files with compiled firmware after the compilation in Figure 36.
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dfh CJC++ - edkdsp_ccfafa_fpl1124p0.c - Xilinx SDK

File Edit Source Refactor Mavigate Search Run
| C - [ -4 - &

|22 ® | & |®™+-| & 0 |:

Project  Xilinx Tools  Window Help

|g-8-d--|%-0-4- |0 =

v o

A= g -

=0l x|

[ Project Explorer 53 =0 a_fpiidipl.c f a_fpii24pd.c 52 a_fpii24pl.c 1”1 =08 » =0
= <"=|=5| F - #include "stdio fpll.h" =] =
E|I:'5 eckdsp_cc ;| #include "a_fpll24p@.h O R
E-=a unsigned char i, j, n, op, led, btn; o
€ a_fp1101p0.c . :
- [I8] a_fpi101pd.h = void main{) { _J stdio_fp1
MEY- fi101pLc] pb2dfu_set(C_PBP_REGBL, B8); - &l a_fp1124
-[Bl a_fr1101nLh op = mb2pb_read_data(); - @ i unsigne
@ a_fp1124p[l.c if (op == C_DFU_OP_WVER) { - @ 1t unsigni
- pb2dfu_set(C_DFU_CNT, @); e -
a_fp1124p0.h — — — n i unsigr
o E ' pb2dfu_set(C_DFU_OP, op); e @ Cunsi
@ a_folizdpl.c badf - "t4ﬁ - 0op @ UNsic
y P u_waitahw(); - @ led : unsic
a_fpl124pLh 1 else { ° :
- || ca_fpllsh n = mb2pb_read_data(); bhﬂ. : unsi
- |= ca.sh B - @ mainf) ;v
-~ [la] stdio_fp11.h =/ pb2lcd_a5c.1:.1:._text-; )i )
E-E tools /" pb2lcd_ascii char(hex_h({n), C_LCD_@4);
H L scii ri ¢ [ H
.- B settings.ch ¥ pb2lcd_ascii_char(hex_1(n), C_LCD 85);
c L
£ edkdsp_fp12_1@ for (i=8; 1< 4; i+4) {
-4, Binaries for (j = 2; 3 <= 3; j++) {
B[l Includes Ims(j, n, op);
(= Release pb2mb_eoc(led);
El-E= src }
@ fil_LFA1101P0_program_store.h 1
% :::_FA]JDlPlJJrogram_store: btn = btn2pb();
: FALL24°0_program,_store. =V pb2lcd_ascii_char(hex_h(btn), C_LCD @E);
IB fil_FA1124P1_program_store.h 1/ pb2lcd_ascii_char(hex_l{bin), C_LCD_®F);
@ fil_FP1101P0_program_store.h led = led2pb();
@ fil_FP1101P1_program_store.h =y pb2lcd_ascii_char(hex_h(led), C_LCD _83);
@ fil_FP1124P0_program_store.h r/ pb2lcd_ascii_char(hex_1(led), C_LCD 8A); =
% Eggzpiléwlilljrogram_smre.h ﬂ » ‘l I ﬂ
- 48 _all.c
@ platform_config.h [2. Problems (z. Tasks (E Consale &3 =| Properﬁes} 2l Terminaq =B -r%-=08
@ platform.c Mo consoles to display at this time.,
B[k platform.h
@ wal_bece_jk.h
@ wal.h
: B lscript.Id
“-[E| README. bt
-3 hw_platform_0
B[ standalone_bsp_0 =

[ edkdsp_cc/aja_fpli0ipi.c

Figure 35: Initial firmware files and C listening of the LMS filter firmware for the EdKDSP.

The EdkDSP firmware before compilation is presented in Figure 35. See also the C code listing of the

firmware for computation of the LM
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4 CJC++ - edkdsp_ccfafa_fpl10ipi.c - Xilinx SDK o ]
File Edit Source Refactor Mavigate Search Run Project Xilinx Tools Window Help
I r9- ul e @ J$-0-a-n B m e
|e® e J il ) | &) -Gl -t
R:.ProjectExplorer bt =0 a_fplioiplec 52 > [€] a_fpl124p0.c 1 a_fpli2dpl.c 1”1 =0 » =0
= <"=|=5| by Binclude "stdio fpll.h" - =
—r #include "a_fpll@ipl.h" _
B e = - OB R
EE;‘ edkdsp_cc unsigned char ah, bh, zh, n, op, led, btn; @ EHE
B a
[ a_fp1101p0.c - wvoid main() { ; .J stdio_fp1
[ a_fp1101pa.h pb2dfu_set(C_PBP_REGB1, @); - ®  a_fp1101
-[€| a_fp1idiplc op = mb2pb_read_data(); - @
-5 a_fp1101pLh f (op == C_DFU_OP_VVER) { - @
N - pb2dfu_set(C_DFU_CNT, @); L e @
a_fp1124p0.c pb2dfu_set(C_DFU_OP, op); e @
- [l a_fp1124p0.h pb2dfu_waitdhw(); @
|6 a_fp1124pLe } else { e
- a_fpli24plh pb2dfu_set(C_DFU_A MEM_ADDR, mb2pb_read_data());
“El ca_fpilsh pb2dfu_set(C_DFU_A_MEM_SADDR, mb2pb_read_data()); N
-2 ca.sh pb2dfu_set(C_DFU_B MEM_ADDR, mb2pb_read_data()); - 8
- FA1101P0.log pb2dfu_set(C_DFU_B _MEM_SADDR, mb2pb_read data());
= F.-'-\IIDLPDIF‘SM pb2dfu_set(C_DFU_Z MEM_ADDR, mb2pb_read_data());
= ’ pb2dfu_set(C_DFU_Z MEM_SADDR, mb2pb_read data());
= FAL101PLlog ah = mb2pb_read data();
- |5l FALIOIPL.PSM pb2dfu_set(C_DFU_A MEM_BANK, ah);
- | FA1124P0.log bh = mb2pb_read_data();
- [£] FA1124P0.PSM pb2dfu_set(C_DFU_B_MEM_BANK, bh);
-] FA1124P1log zh = mb2pb_read_data();
- =] FA1129P 1.PSM FII‘JQEH'—U_SEt(C_DFU_Z_MEM_BJQNK) Zh:lj
E .
pb2dfu_set(C_DFU_A INC, mb2pb_read_data());
:::_FAIIDLF‘DJJrogram_store.h pb2dfu_set(C DFU B INC, mb2pb_read data());
_FA1101P0_program_store.m pb2dfu_set(C_DFU_Z_INC, mb2pb_read_data());
fill_FA1101P1_program_store.h n = mb2ph_read data() - 1;
- 1o| fill_LFA1101P1 program_store.m pb2dfu_set(C_DFU_CNT, n);
- [la] fil_FA1124P0_program_store.h
-] fil_FA1124P0_program_store.m | pb2dfu_set(C_DFU_OP, op}; -
- [l fil_FA1124p1 . ; |_I | |
Lhl il _program_store,h 1| | » b ﬂ
- 12] fill_LFA1124P1_program_store.m = =
[l stdio_fp11.h [£( Problems (ﬁ Tasks (E Console &3 = Propertieﬂ 2l Terminaq ]
B[ tools CDT Build Console [edkdsp] o lE | CH LB | = B -4~
,_, sethngs sh CLT TLIICT + CURUSPL.TLT — d
=1 b edkclsp _fp12_1xE_all elfcheck passed.
.%_ Binaries 'Finished building: edkdsp.elf.elfcheck’
- [alll Incudes
B & Release 11:34:51 Build Finished (took 8s.981ms)
B src
@ fil_FA1101P0_program_store.h | j
J N ‘ Writable | Smart Insert ‘ 1:1 J

Figure 36: Initial setup of shared directory with Windows 7 and Sourcing of PATH

The EdkDSP firmware after the compilation is presented in Figure 36.

See also the C code listing of the firmware for the basic test of vector operations in the (8xSIMD)
EdkDSP platform. To use the compiled headers in the SDK project, use the copy and paste to copy the
binary header files

edkdsp_cc/a/ fill_FA1101P0_program_store.h

edkdsp_cc/a/ fill_FA1101P1_program_store.h

edkdsp_cc/a/ fill_FA1124P0_program_store.h

edkdsp_cc/a/ fill_FA1124P0_program_store.h

to the SDK MicroBlaze AMP project directory: edkdsp fp12_ 1x8 all/src/ and recompile the MicroBlaze project
“edkdsp_fp12_1x8 all”.

The compiled firmware for the (8xSIMD) EdkDSP will be used by the MicroBlaze part of the AMP demo for
programming of the (8xSIMD) EdkDSP accelerators.
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5. Evaluation version of the AMP demo on ZYNQ with (8xSIMD)
EdkDSP package.

The enclosed Evaluation version of the AMP demo on ZYNQ with UTIA (8xSIMD) EdkDSP package can be
downloaded from UTIA www pages free of charge and used for evaluation asymmetric multiprocessing on ZYNQ
[2] together with the four UTIA (8xSIMD) EdkDSP accelerators.

The evaluation package includes one DVD or the www download package with these deliverables:

10 precompiled designs with UTIA (8xSIMD) EdkDSP accelerators for Xilinx ZC702 board [2], compiled in Xilinx
EDK 14.5 and XPS (ISE) 14.5 [6]. The UTIA (8xSIMD) EdkDSP accelerators are compiled with HW limit on number
of vector operations. The termination of the evaluation license is reported in advance by the demonstrator on
the terminal.

The evaluation package includes SDK 14.5 [7] SW projects related to the asymmetric multiprocessing on ZYNQ
with source code for MicroBlaze processor and ARM processor. SW projects support the family of UTIA (8xSIMD)
EdkDSP accelerators for the Xilinx ZC702 board [2].

The evaluation package includes this compiled library:
libwal.a EdkDSP api (SDK 14.5, MicroBlaze) for EdkDSP accelerators on ZC702 board.

This library has no time restriction. The evaluation license is provided by UTIA only for the use with the family of
UTIA EdkDSP accelerators designed for the Xilinx ZC702 board. Source code of this library is owned by UTIA and
it is not provided in this evaluation package.

The evaluation package includes these binary applications for Ubuntu:

edkdsppp EdkDSP C pre-processor binary for Ubuntu (x86 PC) under the VMware Player.
edkdspcc EdkDSP C compiler binary for Ubuntu (x86 PC) under the VMware Player.
edkdspasm EdkDSP ASM compiler binary for Ubuntu (x86 PC) under the VMware Player.

These binary applications have no time restriction. The user of the evaluation package has license from UTIA to
use these utilities for compilation of the firmware for the Xilinx PicoBlaze6 processor inside of the UTIA EdkDSP
accelerators in the 10 precompiled designs for the Xilinx ZC702 board. The source code of these compilers is
owned by UTIA and it is not provided in the evaluation package.

The evaluation package includes demonstration firmware in C source code for the Xilinx PicoBlaze6 processor for
the family of UTIA EdkDSP accelerators for the Xilinx ZC702 board.

The evaluation package also includes compiled versions of this firmware in form of header files .h. These
compiled firmware files can be used for initial test of the UTIA EdkDSP accelerators on the Xilinx ZC702 board
without the need to install the UTIA compiler binaries and the Ubuntu (x86 PC) OS image under the VMware
Player.

On email request to kadlec@utia.cas.cz , UTIA will send 2 DVD CDs (8GB) with the Ubuntu (x86 PC) image for the
VMware Player free of charge.
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6. AMP projects for ZYNQ ZC702 board with evaluation version of
(8xSIMD) EdkDSP for the Artemis EMC2 project partners.

The release version of the AMP HW/SW projects on ZYNQ ZC702 board with evaluation version of the
(8xSIMD) EdkDSP for the partners in the Artemis EMC2 project [9] can be ordered from UTIA AV CR, v.v.i,,
by email request for quotation to kadlec@utia.cas.cz. UTIA will provide quotation by email. After the confirmed
order received by email to kadlec@utia.cas.cz, UTIA AV CR, v.v.i. will deliver (by standard mail) to the
customer the printed version of this application note together with 3 DVDs with deliverables described in this
section. UTIA AV CR, v.v.i., will also send to the EMC2 project partner (by email) and by the standard mail the
invoice for:

Release version of the AMP HW/SW projects on ZYNQ with the evaluation version
of the UTIA (8xSIMD) EdkDSP accelerator cores for the partners
in the Artemis EMC2 project (without VAT) 0,00 Eur

The package includes this application note and the EdkDSP DVD with these deliverables:

10 precompiled designs with UTIA (8xSIMD) EdkDSP accelerators for Xilinx ZC702 board, compiled in Xilinx EDK
14.5 and XPS (ISE) 14.5 [6]. The UTIA (8xSIMD) EdkDSP accelerators are compiled with HW limit on number of
vector operations. The termination of the evaluation license is reported in advance by the demonstrator on the
terminal.

The release version of the AMP HW/SW projects on ZYNQ with the evaluation version of the UTIA (8xSIMD)
EdkDSP accelerator cores for the Artemis EMC2 project partners includes source code of all 10 EDK design
projects demonstrating the asymmetric processing on ZYNQ and the evaluation versions of the UTIA (8xSIMD)
EdkDSP accelerators provided in form of netlisted pcores generated in Xilinx ISE 14.5 [6]:

bce_fpll_1x8 0_axiw_v1_10_a
bce_fp11_1x8_0_axiw_v1l 20_a
bce_fp11_1x8_0_axiw_v1l 30_a
bce_fp11_1x8_0_axiw_v1l 40_a
bce_fp12_1x8_0_axiw_v1l_10_a
bce_fp12_1x8_0_axiw_v1l 20_a
bce_fp12_1x8_0_axiw_v1l 30_a
bce_fp12_1x8_0_axiw_v1l 40_a

These evaluation versions of UTIA (8xSIMS) EdkDSP netlist pcores are compiled with an HW limit on number of
vector operations. Partners in the Artemis EMC2 project [9] have license from UTIA to integrate these
evaluation netlists into their own ISE 14.5 designs and to compile them to unlimited number of bit-streams for
the asymmetric multiprocessing designs on Xilinx ZYNQ FPGAs. This license has no time restriction. The source
code of the evaluation versions of (8xSIMS) EdkDSP accelerators is an IP owned by UTIA and it is not provided in
the release package to the Artemis EMC2 project partners.

The package for the Artemis EMC2 project partners includes the SDK 14.5 SW projects in source code for

MicroBlaze as described in this application note. Projects support the evaluation versions of the UTIA (8xSIMD)
EdkDSP accelerators (in the netlist pcore format) for the Xilinx ZC702 board.
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The package for the Artemis EMC2 project partners includes the library:
libwal.a EdkDSP api (SDK 14.5, MicroBlaze) for EdkDSP accelerators on ZC702 board.

This library has no time restriction. The evaluation license is provided by UTIA only for the use with the family of
UTIA EJkDSP accelerators designed for the Xilinx ZC702 board. Source code of this libray is owned by UTIA and it
is not provided in this evaluation package.

The package for the Artemis EMC2 project partners includes these binary applications for Ubuntu:

edkdsppp EdkDSP C pre-processor binary for Ubuntu (x86 PC) under the VMware Player.
edkdspcc EdkDSP C compiler binary for Ubuntu (x86 PC) under the VMware Player.
edkdspasm EdkDSP ASM compiler binary for Ubuntu (x86 PC) under the VMware Player.

These binary applications have no time restriction. The Artemis EMC2 project partners have license from UTIA to
use these utilities for compilation of the firmware for the Xilinx PicoBlaze6 processor inside of the UTIA EdkDSP
accelerators in the 10 precompiled designs for the Xilinx ZC702 board. The source code of these binaries is
owned by UTIA and it is not provided in the evaluation package.

The package includes demonstration firmware in C source code for the Xilinx PicoBlaze6 processor for the family
of UTIA EdkDSP accelerators for the Xilinx ZC702 board.

The package also includes compiled versions of this firmware in form of header files .h. These compiled firmware
files can be used to evaluate the UTIA EdkDSP accelerators on the Xilinx ZC702 board without the need to install
the UTIA compiler binaries and the Ubuntu (x86 PC) OS image under the VMware Player.

The release package deliverables also includes two DVDs with the Ubuntu (x86 PC) image for the VMware Player
(free of charge). This image is provided to ease the installation of the UTIA EdkDSP C compiler on Windows 7
(32bit or 64bit) in the VMware Player.

Any and all legal disputes that may arise from or in connection with the use, intended use of or license for the

software provided hereunder shall be exclusively resolved under the regional jurisdiction relevant for UTIA AV
CR, v. v. i. and shall be governed by the law of the Czech Repubilic.
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7. AMP release version on ZYNQ with (8xSIMD) EdkDSP package.
I —————————————

The release version of the AMP demo on ZYNQ with UTIA (8xSIMD) EdkDSP package can be ordered from
UTIA AV CR, v.v.i., by email request for quotation to kadlec@utia.cas.cz. UTIA will provide quotation by email.
After the confirmed order received by email to kadlec@utia.cas.cz, UTIA AV CR, v.v.i. will deliver (by standard
mail) to the customer the printed version of this application note together with 3 DVDs with deliverables
described in this section. UTIA AV CR, v.v.i., will send to the customer (by email) and by the standard mail the
invoice for:

Release version of the AMP demo on ZYNQ
with UTIA (8xSIMD) EdkDSP package (without VAT) 400,00 Eur

The release package includes this application note and the EdkDSP DVD with these deliverables:

10 precompiled designs with UTIA (8xSIMD) EdkDSP accelerators for Xilinx ZC702 board [2], compiled in Xilinx
EDK 14.5 and XPS (ISE) 14.5 [6]. The UTIA (8xSIMD) EdkDSP accelerators included in these designs are compiled
with no HW limit on number of vector operations. Therefore, all these precompiled designs of the release
package run on ZC702 without limitations of the evaluation package.

The release package includes source code of all 10 EDK design projects demonstrating the asymmetric
processing on ZYNQ. The UTIA (8xSIMD) EdkDSP accelerators are provided in the form of netlist pcores
generated in Xilinx ISE 14.5 [6]:

bce_fpll_1x8 0_axiw_v1_10_a
bce_fpll_1x8 0_axiw_v1_20_a
bce_fpll_1x8 0_axiw_v1_30_a
bce_fpll_1x8 0_axiw_v1_40_a
bce_fp12_1x8 0_axiw_v1_10_a
bce_fp12_1x8 0_axiw_v1_20_a
bce_fp12_1x8 0_axiw_v1_30_a
bce_fp12_1x8 0_axiw_v1_40_a

These UTIA (8xSIMS) EdkDSP netlist pcores have no HW limit on number of vector operations. The user of the
release package has license from UTIA to integrate these netlists into its own ISE 14.5 designs and to compile
them to unlimited number of bit-streams for the asymmetric multiprocessing designs on Xilinx ZYNQ FPGAs. This
license has no time restriction. The source code of the (8xSIMS) EdkDSP accelerators is an IP owned by UTIA and
it is not provided in the release package to the customer.

The release package includes SDK 14.5 SW projects in source code for MicroBlaze as described in this application
note. Projects support the family of UTIA (8xSIMD) EdkDSP accelerators for Xilinx ZC702 board [2].
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The release package includes the library:
libwal.a EdkDSP api (SDK 14.5, MicroBlaze) for EdkDSP accelerators on ZC702 board.

This library has no time restriction. The evaluation license is provided by UTIA only for the use with the family of
UTIA EdkDSP accelerators designed for the Xilinx ZC702 board. Source code of this library is owned by UTIA and
it is not provided in this release package.

The release package includes these binary applications for Ubuntu:

edkdsppp EdkDSP C pre-processor binary for Ubuntu (x86 PC) under the VMware Player.
edkdspcc EdkDSP C compiler binary for Ubuntu (x86 PC) under the VMware Player.
edkdspasm EdkDSP ASM compiler binary for Ubuntu (x86 PC) under the VMware Player.

These binary applications have no time restriction. The user of the evaluation package has license from UTIA to
use these utilities for compilation of the firmware for the Xilinx PicoBlaze6 processor inside of the UTIA EdkDSP
accelerators in the 10 precompiled designs for the Xilinx ZC702 board. The source code of these compilers is
owned by UTIA and it is not provided in the release package.

The release package includes demonstration firmware in C source code for the Xilinx PicoBlaze6 processor for
the family of UTIA EdkDSP accelerators for the Xilinx ZC702 board.

The release package also includes compiled versions of this firmware in form of header files .h. These compiled
firmware files can be downloaded into the UTIA EdkDSP accelerators for the Xilinx ZC702 board without the
need to install UTIA compiler binaries and the Ubuntu (x86 PC) OS under the VMware Player.

The release package deliverables also includes two DVDs with the Ubuntu (x86 PC) image for the VMware Player
(free of charge). This image is provided to ease the installation of the UTIA EdkDSP C compiler on Windows 7
(32bit or 64bit) in the VMware Player.

Any and all legal disputes that may arise from or in connection with the use, intended use of or license for the

software provided hereunder shall be exclusively resolved under the regional jurisdiction relevant for UTIA AV
CR, v. v. i. and shall be governed by the law of the Czech Republic.
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Disclaimer

This disclaimer is not a license and does not grant any rights to the materials distributed herewith. Except as
otherwise provided in a valid license issued to you by UTIA AV CR v.v.i., and to the maximum extent permitted
by applicable law:

(1) THIS APPLICATION NOTE AND RELATED MATERIALS LISTED IN THIS PACKAGE CONTENT ARE MADE
AVAILABLE "AS IS" AND WITH ALL FAULTS, AND UTIA AV CR V.V.l. HEREBY DISCLAIMS ALL WARRANTIES AND
CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and

(2) UTIA AV CR v.v.i. shall not be liable (whether in contract or tort, including negligence, or under any other
theory of liability) for any loss or damage of any kind or nature related to, arising under or in connection with
these materials, including for any direct, or any indirect, special, incidental, or consequential loss or damage
(including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought
by a third party) even if such damage or loss was reasonably foreseeable or UTIA AV CR v.v.i. had been advised
of the possibility of the same.

Critical Applications:

UTIA AV CR v.v.i. products are not designed or intended to be fail-safe, or for use in any application requiring
fail-safe performance, such as life-support or safety devices or systems, Class Ill medical devices, nuclear
facilities, applications related to the deployment of airbags, or any other applications that could lead to death,
personal injury, or severe property or environmental damage (individually and collectively, "Critical
Applications"). Customer assumes the sole risk and liability of any use of UTIA AV CR v.v.i. products in Critical
Applications, subject only to applicable laws and regulations governing limitations on product liability.
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